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What is IM-MS Browser?
The MassHunter IM-MS Browser is an application that supports interactive 
browsing and visualization of data from single LC-IM-MS data files, extraction 
of various 2D and 3D subsets of that data, finding of features, exporting of 
extracted data in a variety of formats, and collision cross section calculations.

The IM-MS Reprocessing program is a utility that allows you to make certain 
modifications to an existing IM-MS data file. 

IM-MS Browser operates on raw data files.



What’s new in B.07.00?
What’s new in B.07.00?
• You can open All-Ions data files with alternating high/low fragmentation 

frames.

• You can find compounds using four dimensional feature finding (IMFE). 
This algorithm is an extension of the MFE algorithm (Molecular Feature 
Extractor).

• You can review results from the IMFE algorithm in the Feature List window.

• You can copy and compare multiple chromatogram plots in the User 
Chromatograms window.

• You can reorder plots in the User Chromatograms, User Drift Spectra, and 
User Mass Spectra windows.

• You can copy to the Clipboard either all plots or only the selected plots in 
the User Chromatograms, User Drift Spectra, and User Mass Spectra 
windows.

• In the User Chromatogram window, the User Drift Spectra window, and the 
User Mass Spectra window, the plot titles match the colors of the individual 
plots, with an option for dimension-specific coloring of extraction ranges.

• You can start actions using the current method parameters in the Actions 
menu.

• You can smooth drift spectra being viewed in the Frame Viewer.

• You can condense multi-time segment data files to a single frame per time 
segment.

• You can extract data from a polygonal or rectangular range in an abundance 
map in the File Overview.

• You can zoom out slightly in the File Overview window, and the Frame 
Viewer window.

• You can choose whether the abundance map is above or below the spectrum 
in the Frame Viewer window.

• You can clear all custom spectra in the Frame Viewer window with one 
command.

• The Cross Section Calculator supports calculations with alternative (not 
Nitrogen) drift gases. You can set the drift gas in the Tune context in the 
Data Acquisition program in the Manual Tune > IM > Drift Tube tab.

• The Cross Section Calculator calculates the standard error of t0.
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What’s new in B.07.00?
• You can calculate cross sections based on measurements with just a single 
drift field.

• You can extract data from a polygonal/rectangular range of a (DT vs RT) or 
(MZ vs RT) abundance map by filtering an IM-MS data file containing just 
the data in the specified range and creating a file.

• You can display Instrument Curve plots in the File Overview window (for 
example, plots of drift field, pressure or temperature versus retention 
time).
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Features of IM-MS Browser
Features of IM-MS Browser
Here is a list of some of the many things that you can do with the IM-MS 
Browser software.

• Interactive browsing and visualization of data from a single LC-IMS-MS 
data file

• Extract a frame or frame range from IM-MS data

• Examine an abundance map of the IM-MS data

• Extract drift spectra and mass spectra from IM-MS data

• Export extracted data in a variety of formats

• Find features using a four dimensional feature finding algorithm (referred 
to as IMFE)

• Calculate collision cross sections

• Smooth drift spectra being viewed in the Frame Viewer.

• Condense multi-time segment data files to a single frame per time segment.

Where to find more information

Online Help

Help Menu Click Help > Contents to access the contents of the IM-MS 
Browser online Help including basic tasks, user interface, and reference 
information.

Documents

MassHunter Qualitative and Quantitative Analysis 
• Agilent MassHunter Workstation Software Qualitative Analysis 

Familiarization Guide for LC/MS

• Agilent MassHunter Workstation Software Qualitative Analysis 
Familiarization Guide for GC/MS

• Agilent MassHunter Workstation Software Quantitative Analysis 
Familiarization Guide
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Where to find more information
Training

Training Courses  Visit www.chem.agilent.com to view a listing of training 
courses for Mass Profiler.
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Getting Started
How do I get started?
Getting Started

How do I get started?
This Quick Start Guide helps you install IM-MS Browser, become familiar with 
the IM-MS Browser user interface, perform feature extraction, and calculate 
cross sections using your data.

1 Install IM-MS Browser. Follow the instructions in “IM-MS Browser 
Installation” on page 47.

2 Start IM-MS Browser. Double-click the IM-MS Browser icon  located on 
your desktop or in the Agilent MassHunter Workstation desktop folder, or 
click Start > All Programs > Agilent > MassHunter Workstation > IM-MS 
Browser B.07.01.

3 Review this Quick Start Guide to learn about:

• Getting Started

• User Interface

4 Review the online Help to learn about:

• Details of the User Interface

• Concepts

• How-to topics

5 Review the “MassHunter Qualitative and Quantitative Analysis” guides (see 
“Documents” on page 4). These guides help you improve your results by 
covering topics that help you:

• Prepare for an experiment

• Explain the parameters related to finding features
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Getting Started
Terminology
Terminology
Abundance Map A 3D object with ion abundance encoded as a color on a plot whose axes 

represent either (m/z and drift time) or (drift time and retention time) or (m/z 
and retention time). You can see an abundance map in the File Overview 
window and in the Frame Viewer window.

Abundance Map 
Pane

Shows the Drift Time vs the m/z for the selected frame (or frames). This pane 
can be shown in the File Overview window and is one of three panes available 
in the Frame Viewer window. See “Abundance Map pane” on page 42.

Algorithm An algorithm is a set of automated, sequential mathematical tasks performed 
to find, filter, align, extract, compare, and identify features from your 
chromatographic/ mass spectral data sets.

Bookmark A specific location in a data file. You can add a bookmark if you want to be 
able to return to this location.

Cross Section The Agilent mobility device operates under uniform low field conditions, thus 
allowing the drift time information for ions to be directly converted to 
collision cross section information.

Drift Spectrum 
Pane

One of three panes available in the Frame Viewer window. See “Drift Spectrum 
pane” on page 42.

Feature A feature is synonymous with compound which is an ion (and its isotopes) 
generated from a chemical compound. A feature is referred to interchangeably 
with compound, descriptor, element, entity, metabolite, or molecular feature 
during the various steps of analysis using MassHunter software. A feature can 
consist of one or multiple related ions, including isotopes. However, if a 
molecule produces different ionic species (for example, different adducts), 
IMFE will treat each as a separate feature. See “Finding Features” on page 10.

Frame The collection of ion abundance values (each with an associated m/z and drift 
time) acquired at the same retention time is referred to as a “frame”.  The 
frame can also be thought of as a collection of mass spectra observed at 
different drift times, or as a collection of drift spectra observed at different 
m/z values. See “Frame Viewer” on page 40.

IMFE IM-MS Feature Extraction. See also “Finding Features” on page 10.

Mass Spectrum 
Pane

One of three panes available in the Frame Viewer window. See “Mass 
Spectrum pane” on page 42
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Processing and viewing results
Method A method is a set of all the parameters used for processing sample files in an 
IM-MS Browser project, including extracting frame data, smoothing drift 
spectra, finding peaks in drift spectra, finding peaks in mass spectra, and 
calculating collision cross sections (CCS). Methods can be saved using unique 
file names.

MFE Molecular Feature Extraction. See also “Finding Features” on page 10.

Workflow A workflow is a document or a graphical overview that captures a sequence of 
steps to guide you through an analytical task. A workflow may cover more 
than one wizard and may include steps performed by more than one 
MassHunter software program.

Processing and viewing results
The data acquired from each sample appears in these windows: in the File 
Overview window, the Feature List window, the Frame Viewer window, and 
several other window in the main window. In the main window you select how 
to display the data in the File Overview window (see Figure 1 on page 16 and 
Figure 2 on page 17).

Use the File 
Overview to:

• See at a glance how the data varies with retention time in the data file.

• View all of the frames in the data file.

• Select one or more frames in the data file.

See “File Overview” on page 34 for more information.

Use the Frame 
Viewer to:

• See an abundance map of the selected frame/frames.

• See 2D “side plots” (mass spectrum and drift spectrum) which always 
match the visible range of the abundance map.

• Select one or more features to be highlighted in plots, to be exported, or (for 
All Ions files) to have fragmentation spectra extracted and exported.

• Extract one “custom” mass spectrum and/of drift spectrum.

See “Frame Viewer” on page 40 for more information.
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Getting Started
Processing and viewing results
Use the Feature 
List to:

• Investigate specific individual feature details such as retention time, drift 
time, abundance, and Quality.

• Compare information for different features.

See “Feature List” on page 45 for more information.
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Finding Features
The acronym MFE stands for Molecular Feature Extraction.  It is another 
name for the Find by Molecular Feature algorithm. The acronym IMFE stands 
for IM-MS Feature Extraction.

The MFE algorithm (available in other MassHunter applications) treats all of 
the mass spectral data from the experiment as a large, three-dimensional 
array of (retention time, m/z, abundance) values. It removes from that array 
any points that correspond to persistent or slowly-changing background. 
Then, it searches for features that have a common elution profile (for example, 
for masses that elute at very nearly the same time). Those masses are then 
further grouped into one or more "compounds" containing m/z values that are 
related (for example, they correspond to peaks in the same isotope cluster, or 
can be explained as being different adducts or charge states of the same 
entity).

If you have LC/IM-MS data, you find features by IM-MS Feature Extraction (or 
IMFE). IMFE (available in the IM-MS Browser and in Mass Profiler) treats all 
of the mass spectral data from the experiment as a large, four-dimensional 
array of (retention time, drift time, m/z, abundance) values. It removes from 
that array any points that correspond to persistent or slowly-changing 
background. Then, it searches for features that have a common elution and 
drift profile (for example, for masses whose abundances reach a local 
maximum at very nearly the same retention and drift times). Those masses are 
then grouped into one or more "features" containing m/z values that form an 
isotope cluster.

You can use one of the following Extraction algorithms, depending on the 
target data type:

• Chromatographic - Uses the algorithm created for small molecules.

• Infusion - Uses the algorithm created for direct sample injection data.

You also select the Isotope model to use from the following list:

• Common organic molecules - Looks for clusters where the ratio of the 
A+1 and A+2 peaks is consistent with the most common elements in 
small organic molecules (C, H, O, N, S, …) plus chlorine or bromine. 
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Getting Started
Finding Features
• Peptides - The algorithm looks for clusters of peaks that have elemental 
compositions similar to those expected for an ”average” amino acid 
(”Averagine”: C4.94 H7.76 N1.36 O15.99 S0.04).  This model takes into 
account change in isotopic pattern with the increasing molecular weight 
of a peptide.

• Glycans - The algorithm for the glycans model is similar to that for the 
peptide model but assumes the isotope pattern contains C, H, N, O, and S 
in ratios commonly found in carbohydrates.

• Unbiased - The algorithm makes no assumptions about ion 
abundance. Hence, this model is useful when looking for molecules 
containing atoms (besides Cl or Br) whose heavier isotopes have large 
(even dominant) abundances (for example, B, Mo, Fe, etc.).

• Common organic (no halogens) -  Looks for clusters where the ratio of 
the A+1 and A+2 peaks is consistent with the most common elements in 
small organic molecules (C, H, O, N, S, …)
IM-MS Browser Quick Start Guide 11
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Exporting data
Exporting data
You can export data that is visible in the IM-MS Browser (in plots or graphs) in 
the following formats:

• Feature List table - as a Text file (txt, csv), as an Excel file (xls), or as an 
XML file (xml).

• Graphics - as a Text file (txt, csv), as a Graphics file (bmp), or as a Metafile 
(emf).

• Frame - as a CSV file (mass vs. drift grid), CSV (mass, drift, abundance 
triples), or as LC-MS (drift as RT).

Creating data files
You can create two different types of data files from the information in an 
LC-IM-MS data file.

• IM-MS - You can create a filtered IM-MS data file from the current data file, 
retaining data within the boundaries of the current selection and written in 
the IM-MS format. The current selection is a rectangular or polygonal region 
you select in an abundance map. The new data file is created in the same 
folder as the current data file; the name of the new file is the same as the 
current data file with -filter[1] added at the end of the data file name. (the 
number changes depending on how many filtered files you create). You can 
load this data file into the IM-MS Browser software.

• LC-MS - You can create a filtered data file from the current file retaining 
data within the boundaries of the current selection and written in the 
MassHunter LC/MS format. The current selection is a rectangular or 
polygonal region you select in an abundance map. Drift time information is 
removed. Doing this is useful for preparing data files that can be read by 
other MassHunter programs that predate the IM-MS QTOF (for example, 
Qualitative Analysis, Quantitative Analysis, Profinder, etc.)

• This file does not retain any drift time information. Effectively, the data 
for each frame are filtered and then collapsed down to a single mass 
spectrum. This allows you to use the IM-MS Browser to do drift-aware 
background removal from a file which can then be read and processed by 
existing (before IM-MS) versions of MassHunter software.
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Getting Started
Multi-Field CCS and Single-Field CCS
Multi-Field CCS and Single-Field CCS
IM-MS Browser supports two methods of calculating collision cross sections. 
Both use the Mason-Schamp equation that allows you to calculate the CCS 
from a drift time if you also know the pressure, temperature, and some other 
physical constants. To use this equation, the ion's drift time to the end of the 
drift tube is used. However, the observed drift times include the additional 
time it takes the ion to travel from the end of the drift tube to the ion detector 
(the "t0" value). The Agilent system supports two methods of correcting the 
observed drift times. One (the more traditional approach) requires making 
measurements at multiple drift fields. Another requires only measurements at 
a single drift field once some preliminary calibration of the instrument is 
done. These approaches are described below.

Multi-Field CCS
The traditional, multi-field approach corrects the observed drift times for the 
tim it takes to go from the tube exit to the ion detector (the "to" value) by 
making measurements 

By making measurements of observed drift time at various drift field 
strengths, a plot of drift time vs. 1/V is created. This produces a straight line 
whose intercept is the t0 value. Once that is known, the software can correct 
the observed drift times and finish the calculation.

The system makes all that relatively easy. You set up an infusion experiment 
designed to acquire data at several different drift fields; you open that file in 
the IM-MS Browser program; then, you graphically select an ion of interest in 
the data from any one drift field. Then, you can calculate the cross section.

The advantage of the traditional approach is that it calculates the CCS from 
first principles independent of the need for reference compounds (assuming 
that your measurements of temperature, pressure, etc. are accurate). 

The disadvantage of the traditional approach is that it takes time (to acquire 
data at several fields), and therefore a greater amount of sample (which has to 
be infused for that time). It is therefore not useful for determining the CCS of a 
compound that is part of a complex mixture and is only “seen” in a 
chromatographic experiment, where it may be present for only a short time.

See “CCS Calculator (Multi-Field) window” on page 21 and “CCS Plot 
(Multi-Field) window” on page 22.
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Single-Field CCS
Single-Field CCS is an alternative method for getting the post-drift-to-detector 
ion transit time, t0. Agilent discovered that there is a linear relationship 
between the observed drift time and the CCS of an ion (as given by the 
Mason-Schamp equation) when the latter is scaled by the reduced mass of the 
ion and drift gas and the charge state of the ion. The proportionality constants 
between the two can be reduced to two coefficients, which are called “beta” 
and “tfix”.   Those coefficients depend on the operational parameters of the 
instrument (for instance, drift temperature, pressure, and field strength), but 
they can be very easily calibrated by a simple measurement of the observed 
drift times of a few ions with known collision cross sections.

Once those coefficients are determined, then a CCS can be calculated for any 
ion from its mass and charge state and an observed drift time at the single 
field for which the coefficients were determined. This means that the CCS for 
any feature which is found in a chromatographic run can be determined, even 
if it’s only present for a very short time.

The most typical procedure for enabling Single-Field CCS is:

1 Acquire reference ion data. Acquire a short infusion run including the 
reference ions to be used for the calibration. The Agilent tune mix is 
perfectly adequate for this purpose, as the cross sections for these ions are 
all known.

2 Compute single-field CCS coefficients. Open the reference file in the 
Browser and open the CCS Calibration (Single-Field) window. Select the 
reference set that contains the ions in your reference data (typically, the 
Agilent ESI Tune Mix (pos)).   Click Find Drift Times to automatically 
find the drift times for each of the ions in the reference set and compute the 
coefficients.

3 Save the single-field CCS coefficients. The coefficients can be saved in

a One or more already-acquired data files. Once this is done, then CCS 
values are automatically computed for each feature whenever feature 
finding is done on the data in any of these files.

b As the instrument default. This will be automatically copied into any new 
data files acquired after the coefficients are saved. Whenever feature 
finding is done on any of those files, CCS values will be automatically 
computed.
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Getting Started
Multi-Field CCS and Single-Field CCS
Note that the CCS Calibration (Single-Field) window also allows you to 
calculate the coefficients from manually-entered data (i.e., you could enter the 
known cross sections and observed drift times of a set of ions from data 
copied out of your lab notebook, without having a data file open in the 
Browser).

See “CCS (Single-Field) window” on page 21.
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Main functional areas
User Interface

Main functional areas
The main Mass Profiler window consists of two parts: (1) the Menu Bar and (2) 
the Main Window. Additional windows, each dedicated to some specific 
purpose, may be docked within the main window (three are shown in 
Figure 1). Many dockable windows have toolbars.

Figure 1 The main functional areas of IM-MS Browser after IMFE is executed and a frame extracted. You can 
also calculate Collision Cross Section as shown in Figure 2 on page 17.
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User Interface
Main functional areas
1. Menu Bar

The menu bar provides actions that are used for managing your projects, 
methods, display, and identifying features.

Figure 2 You can calculate the cross section when you right-click in the Frame Viewer window and click Cal-
culate CCS (Multi-Field).
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User Interface
Main functional areas
2. Toolbars
The main window does not contain a toolbar. However, most windows contain 
a toolbar which appears at the top of the window. You use these toolbars to 
perform common tasks. Several toolbars are discussed with in the section 
about each window.

3. Main Window
The main window, see Figure 1 on page 16, is further divided into separate, 
dockable windows. You click the commands in the View menu to toggle 
whether a window is visible. You can rearrange these windows by dragging 
their title bars (see “Change the position or tab the windows” in the online 
Help). Many of the dockable windows have shortcut menus that you can access 
by right-clicking within the window.

File Overview window You can select one of four views for the File Overview 
window, all of which show how some aspect of the data varies with retention 
time (the horizontal axis). This window has both a toolbar and a shortcut 
menu. See “File Overview” on page 34.

Figure 3 Icons to use to switch the view in the File Overview Window

Frame Viewer window This window always shows the ion abundance as a 
function of drift time and m/z for the retention time or retention time range 
that you select in the File Overview window. You can view the abundance map 
for the extracted frame. You can also see a drift spectrum and a mass 
spectrum from the selected area in the abundance map. Many features are 
available from the toolbar and the shortcut menu. Each pane has its own 
shortcut menu with commands tailored to that pane. See “Frame Viewer” on 
page 40.
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Main functional areas
Figure 4 Three different panes in the Frame Viewer window: Abundance Map, Drift 
Spectrum, and Mass Spectrum. The Abundance Map pane can show a fea-
ture plot in addition to (or instead of) the abundance map.

Frame Information window This window provides additional information 
about the frame that is currently shown in the Frame Viewer window. 
Additional information may be available depending on the sample information 
stored when the data file was acquired. This window has a shortcut menu.

Figure 5 Information on the current frame is shown in the Frame Information window
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Drift Spectrum Peak List window This window provides additional 
information about the drift spectrum that is currently shown in the Frame 
Viewer window. The table in the window has a different column for each piece 
of information. Each row shows a different peak in the drift spectrum. 

This table may also show a custom drift spectrum or a feature drift spectrum. 
The peak list shows the peaks for the topmost visible spectrum. If multiple 
spectra are visible, they are feature spectrum, custom spectrum, and dynamic 
spectrum. You create a custom drift spectrum when you extract spectra from 
the abundance map pane in the Frame Viewer window.

Figure 6 Information on each peak in the Drift Spectrum

Mass Spectrum Peak List window This window provides additional 
information about the mass spectrum that is currently shown in the Frame 
Viewer window. The table in this window has a different column for each piece 
of information. Each row shows a different peak in the mass spectrum.

If a custom mass spectrum exists, then this table shows the peaks for the 
custom mass spectrum. Otherwise, it shows the dynamic mass spectrum. You 
create a custom mass spectrum when you extract spectra from the abundance 
map pane in the Frame Viewer window.

Figure 7 Information on each peak in the Mass Spectrum

Feature List window This table shows the features that are found when you 
run the Find Features algorithm. See “Finding Features” on page 10.
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Figure 8 Information on each of the features is shown in the Feature List window

CCS (Single-Field) window You find Drift Times and save the calibration 
values in this window. See “Multi-Field CCS and Single-Field CCS” on page 13.

Figure 9 CCS Calibration (Single-Field) window

CCS Calculator (Multi-Field) window You enter the parameters in this window 
that you use when calculating the cross section. You can enter some of these 
parameters automatically when you use the Calculate CCS (Multi-Field) 
command in the Frame Viewer window. See “Multi-Field CCS and Single-Field 
CCS” on page 13.
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Figure 10 Parameters for the CCS Calculator (Multi-Field) window

CCS Plot (Multi-Field) window This window shows a plot of the observed drift 
time (tD) versus the inverse of the drift region voltage change. As rows are 
added to (or modified in) the CCS Calculator (Multi-Field) window, the points 
shown in the plot are updated. See “Multi-Field CCS and Single-Field CCS” on 
page 13.

Figure 11 CCS Plot (Multi-Field) window

User Chromatograms window You can examine and compare chromatograms 
in this window. The File Overview window is restricted to showing a single 
chromatogram at a time, but you can copy multiple chromatograms into this 
window in order to compare them. User chromatograms are not cleared when 
a data file is closed, so you can also use this window to compare 
chromatograms from different files.
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Figure 12 User Chromatograms window

User Mass Spectra window You can examine and compare mass spectra in 
this window. The Mass Spectrum pane in the Frame Viewer window is 
restricted to showing one or two spectra at a time, but you can copy multiple 
spectra into this window in order to compare them. User mass spectra are not 
cleared when a data file is closed, so you can also use this window to compare 
mass spectra from different files.

Figure 13 User Mass Spectra window

User Drift Spectra window You can examine drift spectra in this window. The 
Drift Spectrum pane in the Frame Viewer window is restricted to showing one 
or two drift spectra at a time, but you can copy multiple drift spectra into this 
window in order to compare them. User drift spectra are not cleared when a 
data file is closed, so you can also use this window to compare drift spectra 
from different files.
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Figure 14 User Drift Spectra window
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Menu bar
The following menu items are available in IM-MS Browser:

• “File menu”

• “Edit menu” on page 25

• “View menu” on page 26

• “Actions menu” on page 29

• “Frame menu” on page 30

• “Help menu” on page 32

File menu

You can only have one data file open at a time. 

Open (*.d)  Opens the Open Data File dialog box. This command is available 
only when you do not have a data file open. You can also press Ctrl and O at the 
same time.

Close File Opens the Close File message box. If you click Yes, then the Open 
Data File dialog box is opened automatically. This command is available only 
when you do have a data file open.

Exit Closes the IM-MS Browser window and exits the program. 

Edit menu

Unzoom Undoes the last zoom in the selected window. This command can 
unzoom in any plot window. It is only available if you have zoomed in the 
current window. You can also press Ctrl and Z at the same time.
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Copy to Clipboard Copies the current selection to the Clipboard. This 
command is only available if you have a selection in the current window. You 
can also press Ctrl and C at the same time.

View menu

You can toggle whether a window is visible or not using this menu. If the icon 
next to the command has an orange background, then it is visible. In this 
example, only the Frame Viewer window would be visible.

File Overview Toggles whether the File Overview window is visible.

Frame Viewer Toggles whether the Frame Viewer window is visible.

Frame Information Toggles whether the Frame Information window is visible.

Drift Spectrum Peak List Toggles whether the Drift Spectrum Peak List 
window is visible.

Mass Spectrum Peak List Toggles whether the Mass Spectrum Peak List 
window is visible.

Feature List Toggles whether the Feature List window is visible.

CCS Calibration (Single-Field) Toggles whether the CCS Calibration 
(Single-Field) window is visible.
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CCS Calculator (Multi-Field) Toggles whether the CCS Calculator (Multi-Field) 
window is visible.

CCS Plot (Multi-Field) Toggles whether the CCS Plot (Multi-Field) window is 
visible.

User Chromatograms Toggles whether the User Chromatograms window is 
visible.

User Drift Spectra Toggles whether the User Drift Spectra window is visible.

User Mass Spectra Toggles whether the User Mass Spectra window is visible.

Restore Default Window Layout Restores the window layout to the original 
factory defaults. Some of the information saved in a window layout is the size 
of each window, the dock position for each window, and visibility for each 
window.

Method menu

These commands allow you to change parameters that control some of the 
operations that the IM-MS Browser can perform.

Open Opens the Select *.m dialog box. You can load the parameters from a 
different method.
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Save Saves the current method.

Save As Opens the Select *.m dialog box. You can save the parameters to a 
different method name.

Edit Bookmark Opens the Edit Bookmark dialog box. A “bookmark” defines a 
location in a data file that includes specified drift times and/or m/z values. If 
no acquisition time range is specified, the bookmark is interpreted as “the 
specified drift/mass region in the currently displayed frame”.

Extract Frame Data Opens the Extract Frame Data dialog box. You can set an 
abundance threshold that is used when reading data from the file (for example 
to filter out very low-abundance points likely to represent background noise).

Smooth Drift Spectrum Opens the Smooth Drift Spectrum dialog box. You 
select the type of smoothing algorithm to use and the width to use in the 
algorithm.

Find Peaks in Drift Spectrum Opens the Find Peaks in Drift Spectrum dialog 
box. You can change parameters or re-apply those parameters to the current 
drift spectrum which is the “topmost” drift spectrum in the Frame Viewer 
window (it affects whichever visible spectrum in ‘on top” in the drift spectrum 
pane).

Find Peaks in Mass Spectrum Opens the Find Peaks in Mass Spectrum dialog 
box. You can change parameters and apply those parameters to the current 
mass spectrum.

Calculate CCS (Multi-Field) Opens the Calculate CCS (Multi-Field) dialog 
box.

Filter Features Opens the Feature Filters dialog box. You can filter the 
features that are shown after running the Find Features algorithm.

Find Features (IMFE) Opens the Feature Finder Parameters (IMFE) dialog 
box. These parameters affect the Find Features algorithm.

Extract Fragmentation Spectra Opens the Extract Fragmentation Spectra 
dialog box. You can change parameters which are used to extract 
fragmentation (“MS/MS”) spectra of features found in high/low fragmentation 
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data files. These parameters are used when you click Actions > Export 
Fragmentation Spectra or use the Export Fragmentation Spectra shortcut 
command in the Feature List window.

File Operations Opens the File Operations dialog box which allows you to 
specify actions to take after generating a new, filtered data file or after 
condensing the current file.

Actions menu
The commands in this menu perform a variety of actions.

Show Method Bookmark Draws the current Spectrum Selection Region on the 
abundance map in the Frame Viewer Window, replacing any current selection 
region shown there and changes the active selection tool in the Frame Viewer 
Window (rectangle or polygon) to match the type of region that is in the 
bookmark.  It does not extract any data, change frames, or change the zoom 
level. The current bookmark is defined in the Edit Bookmark dialog box.

Go to Method Bookmark Extracts a new frame from the current data file (if 
specified by the bookmark) and displays that frame in the abundance map in 
the Frame Viewer Window.  The spectrum selection region is drawn on the 
abundance map, and finally the drift and/or mass spectra is extracted as 
specified in the bookmark. The current bookmark is defined in the Edit 
Bookmark dialog box.
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Smooth Drift Spectra Smooths all current drift spectra in the Frame Viewer > 
Drift Spectrum pane. This command affects all drift spectra in the pane, not 
just the “topmost” one, whether currently visible or not. The parameters in the 
Smooth Drift Spectra dialog box are used. You can change the parameters if 
you click the Method > Smooth Drift Spectra command.

Restore Drift Spectra Removes any smoothing that was done on the drift 
spectra.

Clear Feature Highlights Removes the highlighting from any row in the 
Feature List window and removes highlighting from all features shown in the 
feature plot(s) in the File Overview window and/or Frame Viewer window. You 
can highlight one or more rows in the Feature List table. This command allows 
you to instead highlight no rows in the Feature List table.

Find Features Runs the IMFE algorithm. See “Finding Features” on page 10.

Reload Features Reloads any features that have been deleted. When IMFE is 
run (in the IM-MS Browser or in Mass Profiler), the detected features are 
saved as results in the data file folder. This action loads all saved features 
without having to rerun the algorithm (which can save a lot of time) 
Newly-found (or loaded) features are displayed in the feature list and (if 
enabled by the toolbar icon) the feature plot in the abundance map panes.

Delete All Features Removes all features from the Feature List window and 
also from abundance map panes.

Export Fragmentation Spectra Opens the Fragmentation Spectrum Export 
Options dialog box. This command is only visible if the current data file is an 
All Ions data file.

Condense File Creates a new data file which is condensed from the current 
data file. The name of this file has “_condensed[1]” appended to it. The 
number increments if you create more than one condensed data file. This 
command condenses a multiple time segment data file to either a single frame 
per time segment data file or to a frame for every group of adjacent frames.

Frame menu
These commands let you change the frame that is displayed in the Frame 
Viewer window.
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Previous  Changes the data that is displayed in the Frame Viewer window to 
the next lower frame.

Frame (number/minutes/seconds) Displays the frame number or acquisition 
time (or a range of frame numbers or acquisition times) of the data currently 
shown in the Frame Viewer window, in current retention time units. You can 
type a new number (or range as two numbers separated by a dash) in this 
editable text box.

Next Changes the data that is displayed in the Frame Viewer window to the 
next higher frame.

Configuration menu
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Show Drift Spectra on Horizontal Axis
Show Drift Spectra on Vertical Axis Controls whether the horizontal axis of 
the abundance map in the Frame Viewer window shows the drift time 
dimension or the mass dimension. The other dimension is shown on the 
vertical axis.

Set Chromatogram Units to Frame Number
Set Chromatogram Units to Minutes
Set Chromatogram Units to Seconds Controls whether the acquisition time in 
shown as a frame number (1, 2, ... numbered from the start of the run), as time 
in minutes, or as time in seconds.

Set Drift Spectrum Units to Drift Bins
Set Drift Spectrum Units to Milliseconds Controls whether drift times are 
displayed as times in drift bins (0, 1, 2, ...) or milliseconds.

Set Mass Spectrum Units to Mass to Charge
Set Mass Spectrum Units to Nanoseconds Controls whether the mass values 
are shown as m/z or as flight time (in nanoseconds) in the Frame Viewer 
window and the User Mass Spectra window.

Show Abundance Map Above Spectrum
Show Abundance Map Below Spectrum Controls whether the abundance map 
is shown above or below the spectrum pane in the Frame Viewer window.

Numeric Precision Opens the Display Digits dialog box. You set the number of 
digits to show after the decimal when displaying values in various units.

Plot Display Options Opens the Common Plot Display Options dialog box.

Help menu
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Contents Opens the online help window for IM-MS Browser with the 
Contents tab displayed.

Index Opens the online help window for IM-MS Browser with the Index tab 
displayed.

Search Opens the online help window for IM-MS Browser with the Search 
tab displayed.

About Displays the version information for IM-MS Browser.
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File Overview
The File Overview window, as its name 
implies, gives you an overview of an 
entire data file in any of several different 
formats: chromatogram plot mode, frame 
selector mode, and abundance map 
and/or feature plot mode. These modes 
are described below. The acquisition time 
axis of the overview data can be displayed in frame number (especially useful 
for short infusion experiments) or time units of minutes or seconds (especially 
useful for chromatographic experiments). From this window you can specify a 
specific time (or time range) or frame (or frame range) that you wish to 
examine more closely, and the summed data from that time range is shown in 
the Frame Viewer window.

In the File Overview and Frame Viewer windows, different colors are used to 
represent the three different dimensions of data (retention time, drift time, 
and mass-to-charge). 

• Chromatogram plots are shown in green. When a retention time (or 
frame number) range is shown in a plot title (for example, in a mass 
spectrum or drift spectrum), that text is also in green. 

• The dynamic drift spectrum is shown in red (a custom drift spectrum 
overlay is in black). Drift time ranges in other plot titles are always 
shown in red.

• The dynamic mass spectrum is shown in blue (a custom mass spectrum 
overlay is in black). Mass ranges in other plot titles are always shown in 
blue.

The following main headings and actions are presented:

• “Chromatogram Mode” on page 35

• “Frame Selector Mode” on page 35

• “Abundance Map Mode” on page 36

• “Feature Plot Option” on page 36

• “File Overview Toolbar” on page 37
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Chromatogram Mode
If you click  in the File Overview toolbar, then the chromatogram is 
displayed. The chromatogram display is similar to chromatogram plots in 
MassHunter Qualitative Analysis. Significant differences include the optional 
choice of frame number for x-axis units and the fact that the plot title shows a 
drift time range for chromatograms that are based on a restricted drift time 
range in addition to an m/z range.

Figure 15 Chromatogram Mode in the File Overview window

Frame Selector Mode
If you click  in the File Overview toolbar, the “frame selector” display is 
shown. This display is most useful for selecting frame(s) from files 
representing short runs (e.g., infusion experiments with only a couple dozen 
frames). It simply presents a set of boxes, one per frame, annotated with the 
frame number and frame time.  The example shown here, from the same data 
file, shows what happens when there is a large number of frames – most of 
them overlap and are unreadable, but a region around the currently selected 
frame is magnified, so its annotations can be read. 

The frame (or frames) currently displayed in the Frame Viewer window are 
highlighted with a dark blue border. You select an individual frame for display 
in the Frame Viewer window by clicking on any magnified box.  You can sum 
frames over a range of frame numbers by first clicking on the box for the frame 
at one end of the range, and then pressing the Shift key while clicking on the 
box for the frame at the other end of the range.
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Figure 16 Frame Selector Mode in the File Overview window

Abundance Map Mode
If you click  in the File Overview toolbar, the overview Abundance Map 
display is shown. The overview abundance map has a horizontal axis 
representing the frame number or retention time and a vertical axis that 
represents either drift time or m/z. The plot is filled with colored “bins” where 
the color of each bin encodes a measure of the ion abundance at the drift time 
and retention time (or at the m/z and retention time) location of the bin. The 
following is an abundance map from the same data file as the TIC just above.

Figure 17 Abundance Mode in the File Overview window

Feature Plot Option
If you click  in the File Overview toolbar, the Feature Plot is displayed, 
using the same axes as the abundance map (either drift time or m/z vs 
acquisition time). If you click this option when the Chromatogram mode or the 
Frame Selector mode is selected, then the features are shown in a plot without 
the Abundance Map. You can toggle the Abundance Map on and show the 
Feature Plot together with the Abundance Map.
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Figure 18 Feature Plot Option with the Abundance Mode in the File Overview window

File Overview Toolbar 
The following toolbar options are available in IM-MS Browser. 

Button Action or Equivalent menu item


File > Open (*.d)


File > Close File


Edit > Unzoom. This command does a 
stepwise unzoom.


Scales the X-axis and Y-axis automatically


Displays only high fragmentation ions. This 
icon is only visible when the current data file 
contains high/low fragmentation data.


Displays only low fragmentation ions. This 
icon is only visible when the current data file 
contains high/low fragmentation data.


Displays sum of frames in each fragmentation 
cycle. This icon is only visible when the 
current data file contains high/low 
fragmentation data.
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Displays interleaved high and low 
fragmentation frames. This icon is only visible 
when the current data file contains high/low 
fragmentation data.


Switches to Chromatogram mode. See 
“Chromatogram Mode” on page 35.


Switches to Frame Selector mode. See “Frame 
Selector Mode” on page 35.


Switches to Abundance Map mode. If the 
feature plot is shown, toggles the Abundance 
Map display. See “Abundance Map Mode” on 
page 36.


Shows the Feature Plot option. If the 
Abundance Map is also shown, toggles the 
feature plot display. You can see the 
Abundance Map and the Feature Plot together. 
See “Feature Plot Option” on page 36.


Frame > Previous

Acquisition time 
or Frame Number


Shows the extraction range of the frame seen 
in the Frame Viewer window. The frame or 
frame range is shown in current units (frame 
number, minutes, or seconds). You can edit 
this value to set the frame or retention time 
range.


Frame > Next


Switches to movie mode. The selected frame 
is automatically incremented after being 
displayed for a short time.

Button Action or Equivalent menu item
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Chromatogram 
signal to display


Shows the current signal which is displayed. 
Possible signals include TIC, BPC, EIC at zoom 
limits, Drift Field, Drift Pressure, and Drift 
Temperature. These signals are only visible in 
Chromatogram mode. This list is enlarged 
when you extract custom EICs.

Abundance Map 
signal to display


Shows the current type of abundance map. 
Possible signals include “DT vs. RT (Total 
Abundance)”, “DT vs. RT (Base Abundance)”, 
“DT vs. MZ (Total Abundance)”, and “MZ vs. 
RT (Base Abundance)”. These signals are only 
visible in Abundance Map mode. This list is 
enlarged when you extract custom Abundance 
Maps.


Switches to the rectangular selection tool in 
the abundance map and the feature plot.


Switches to the polygonal selection tool in the 
abundance map and the feature plot.


Shows the X-axis, Y-axis, and Z-axis 
coordinates for the current cursor position. 
The values are displayed at the end of the 
toolbar.

Button Action or Equivalent menu item
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Frame Viewer
The Frame Viewer shows the data from the 
time range selected in the File Overview 
window as an abundance map of ion 
abundance with axes of drift time and 
m/z. Two 2D “side plots” (mass spectrum and 
drift spectrum) are below (or above) and to 
the left of the abundance map. The x-axis 
ranges of these side plots always match the 
visible range of the abundance map. The side 
plots can always show a “dynamic spectrum” 
that shows the ion abundance summed across 
the portion of the data visible in the 
abundance map; these spectra change 
whenever the abundance map is zoomed or shifted. 

In addition, you can extract one additional “custom” mass spectrum and/or 
drift spectra. The custom spectra are overlaid on the side plots.  They each 
have abundances that are summed across the range you specify at the time the 
spectrum is extracted. That range may be smaller or larger than the current 
abundance map range, and the custom spectra do not change as the 
abundance map is zoomed.

Finally, if the Find Features algorithm has been run, a feature plot may be 
shown in the abundance map pane. Whenever a feature is highlighted and the 

 icon is enabled, the side plots also show a feature (mass or drift) spectrum 
for the most recently-highlighted feature.

The following sections and actions are presented:

• “What is a frame?” on page 41

• “Abundance Map pane” on page 42

• “Drift Spectrum pane” on page 42

• “Mass Spectrum pane” on page 42

• “Toolbar” on page 43

• “Plot mouse actions” on page 44

• “Plot shortcut actions” on page 45
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What is a frame?
A data file contains a series of frames, each identified by a frame number (1, 2, 
etc.) that indicates the order in which they were acquired. A frame can also be 
identified by the time (since the beginning of the run) when the data in that 
frame was acquired. That time is referred to as the “acquisition time” or the 
"retention time", even though the latter term strictly applies only when the 
sample is being chromatographed during the run. So, a frame may be 
identified by either its frame number or by its retention acquisition time (in 
units of minutes or seconds).

When dealing with a high/low fragmentation data file, the frames are treated 
as belonging to acquisition “cycles”.  Each cycle includes one high and one low 
fragmentation frame (either in that order, or in reversed order) – unless a 
frame is dropped in acquisition in which case that cycle would hold only one 
frame.

To reduce the number of variations that you might have to deal with, this 
program follows this paradigm:

• Whenever you direct the IM-MS Browser to extract a frame or frame 
range, the IM-MS Browser automatically extracts all the frames that 
belong in any cycle included in your specification.  The IM-MS Browser 
always extracts data from complete cycles.

• The IM-MS Browser accumulates multiple frames (multiple cycles) as 
summed data.  However, it internally maintains separate sums of the 
low and high fragmentation data.

• Controls in the File Overview window and the Frame Viewer window let 
you easily choose how the extracted high/low fragmentation data is to be 
displayed.  That choice includes whether to show only the low 
fragmentation data, only the high fragmentation data, or both.  In some 
cases, there will be options for how mixed low/high data is to be 
presented. 

Note that these controls are only visible if the currently open data file contains 
high/low fragmentation data.
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Abundance Map pane
The Abundance Map pane shows the Drift 
Time vs the m/z for the selected frame. The 
data shown in this pane is either or both of an 
abundance map and a feature plot. You 
control which of these is visible by toolbar 
icons (  and ). As you zoom in the 
abundance map, the dynamic spectra in the 
Drift Spectrum pane and the Mass Spectrum 
pane also change.

Many actions can be performed using the shortcut menu and the toolbar.

Drift Spectrum pane

You can display up to three overlaid drift spectra in the 
Drift Spectrum pane. One of the spectra is a dynamic 
spectra that is summed across the visible range of the 
abundance map in the Frame Viewer window. Another 
spectrum is a custom spectra that is extracted from a 
mass range that you specify. A feature drift spectrum is 
derived from all of the individual (RT, DT, m/z) data 
points that the feature finder grouped as part of the 
feature (this may include points from a retention time range that 
doesn’t exactly match that of the abundance map) The dynamic spectra 
and the custom spectra displayed in this window are always from the 
same frame (or frame range) in a single data file.

Mass Spectrum pane
You can display up to three overlaid mass 
spectra in the Mass Spectrum pane. One of 
the spectra is a dynamic spectra that is 
summed across the visible range of the 
abundance map in the Frame Viewer window. Another spectrum is a custom 
spectra that is extracted from a mass range that you specify. A feature mass 
spectrum is derived from all of the individual (RT, DT, m/z) data points 
that the feature finder grouped as part of the feature (this may include 
points from a retention time range that doesn’t exactly match that of 
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the abundance map). The dynamic spectra and the custom spectra 
displayed in this window are always from the same frame (or frame 
range) in a single data file.

Toolbar
The following toolbar options are available in the Frame Viewer window. 

Button Action or Equivalent menu item


Edit > Unzoom


Scales the X-axis and Y-axis automatically


Displays a single spectrum in the Drift 
Spectrum pane and the Mass Spectrum pane. 
If a feature spectrum is available, that 
spectrum is given preference. Otherwise, if a 
Custom Spectrum is available, that spectrum 
is given preference.


Toggles whether feature spectra are shown in 
the drift spectrum pane and the mass 
spectrum panes. These spectra are shown 
only if there is a feature highlighted (in the File 
Overview or Frame Viewer plots or in the 
Feature List table). They are shown whether or 
not the feature falls within the retention time 
range of the other data shown in the Frame 
Viewer window.


Displays only high fragmentation spectra in 
the Drift Spectrum pane and the Mass 
Spectrum pane. This icon is only visible for 
high/low fragmentation data files.
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Plot mouse actions
Zoom: Right-click and drag within any of the panes to define an area to 
enlarge. The area expands when you release the mouse button.

Select: Click and drag to draw a selection range (2D plots) or region 
(abundance map or feature plots). The current selection range may then be 
used as the basis for many shortcut menu items.


Displays only low fragmentation spectra in the 
Drift Spectrum pane and the Mass Spectrum 
pane. This icon is only visible for high/low 
fragmentation data files.


Toggles whether to show the abundance map 
in the Abundance Map pane. You have to 
either have the Abundance map or the Feature 
Plot displayed.


Toggles whether or not to show the 3D 
features in the Abundance Map pane.


Sets the display mode for the abundance map 
when you have a High/Low fragmentation 
data file. This icon is only visible for high/low 
fragmentation data files.


Switches to the rectangular selection tool. A 
selection is used for many shortcut 
commands.


Switches to the polygonal selection tool.


Shows the X-axis, Y-axis, and Z-axis 
coordinates for the current cursor position. 
The values are displayed at the end of the 
toolbar.

Button Action or Equivalent menu item
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Select: If you click , then you can select a polygonal range or region. You 
click the starting location. Then, click additional locations to form the polygon. 
A dashed line is drawn to show the current sides of the polygon. When you 
move the cursor close to the starting location, the cursor changes to show a 
circle. If you click in that circle, the polygon is complete.

Plot shortcut actions
The shortcut menu is different for each of the three panes in the Frame Viewer 
window.

Feature List
This window contains a table describing each 
feature which was found when you ran the 
Find Features (IMFE) algorithm. Features are 
only listed in this table if they satisfy all of 
the filters which you set.

The following sections and actions are 
presented:

• “Feature List table”

• “Feature List toolbar” on page 46

Feature List table

Each feature is shown in a different row in the table. The following columns 
are available for each feature:

• Abund - the height or volume, depending on the parameter settings in 
the Feature Visibility dialog box which you open when you click Method 
> Filter Features.

• DT - the drift time

• Feature - a number associated with this feature

• Ions - the number of ions

• Mass - the neutral mass of the ion computed from the m/z

• m/z - the mass to charge value

• Quality - a quality score from 0 to 100
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• RT - the retention time

• Z - the charge state

•  (A2) - the collision cross section calculated from the data in this row

Feature List toolbar
he following toolbar options are available in the Frame Viewer window. 

Button Action or Equivalent menu item


Does not change the position of the 
highlighted features.


Changes the position of the highlighted 
features in the table to always be at the top of 
the table.
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IM-MS Browser Installation
1 Install IM-MS Browser on the highest performing computer you have 

available to reduce the time it takes to extract and view the features in your 
sample files. IM-MS Browser requires a computer running Windows 7 
(64-bit) with at least 8GB of RAM.

Note: For better processing performance choose a higher frequency CPU 
over a larger number of cores. A solid-state hard drive can improve 
performance specifically when extracting a lot of files. Depending on the 
size of a project, and the number of features extracted per data file, 
additional RAM reduces processing time by minimizing the use of the page 
file used during the process.

2 If an earlier version of IM-MS Browser is already installed on your 
computer, remove the earlier version of the software before installing 
IM-MS Browser B.07.01.
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